
Chapter 1: Fluid Flow and Heat Transfer in a Mixing
Elbow
This tutorial is divided into the following sections:

1.1. Introduction

1.2. Prerequisites

1.3. Problem Description

1.4. Setup and Solution

1.5. Summary

1.1. Introduction

This tutorial illustrates the setup and solution of a three-dimensional turbulent fluid flow and heat
transfer problem in a mixing elbow. The mixing elbow configuration is encountered in piping systems
in power plants and process industries. It is often important to predict the flow field and temperature
field in the area of the mixing region in order to properly design the junction.

This tutorial demonstrates how to do the following:

• Launch ANSYS Fluent.

• Read an existing mesh file into ANSYS Fluent.

• Use mixed units to define the geometry and fluid properties.

• Set material properties and boundary conditions for a turbulent forced-convection problem.

• Create a surface report definition and use it as a convergence criterion.

• Calculate a solution using the pressure-based solver.

• Visually examine the flow and temperature fields using the postprocessing tools available in ANSYS Fluent.

• Adapt the mesh based on the temperature gradient to further improve the prediction of the temperature
field.

1.2. Prerequisites

This tutorial assumes that you have little or no experience with ANSYS Fluent, and so each step will be
explicitly described.
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1.3. Problem Description

The problem to be considered is shown schematically in Figure 1.1: Problem Specification (p. 2). A
cold fluid at 20° C flows into the pipe through a large inlet, and mixes with a warmer fluid at 40° C that
enters through a smaller inlet located at the elbow. The pipe dimensions are in inches and the fluid
properties and boundary conditions are given in SI units. The Reynolds number for the flow at the larger
inlet is 50,800, so a turbulent flow model will be required.

Note:

Since the geometry of the mixing elbow is symmetric, only half of the elbow must be modeled
in ANSYS Fluent.

Figure 1.1: Problem Specification
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1.4. Setup and Solution

To help you quickly identify graphical user interface items at a glance and guide you through the steps
of setting up and running your simulation, the ANSYS Fluent Tutorial Guide uses several type styles and
mini flow charts. See Typographical Conventions Used In This Manual (p. xxiii) for detailed information.

The following sections describe the setup and solution steps for running this tutorial in serial:

1.4.1. Preparation

1.4.2. Launching ANSYS Fluent

1.4.3. Reading the Mesh

1.4.4. Setting Up Domain

1.4.5. Setting Up Physics

1.4.6. Solving

1.4.7. Displaying the Preliminary Solution

1.4.8. Adapting the Mesh

1.4.1. Preparation

1. Download the introduction.zip file here.

2. Unzip introduction.zip to your working directory.

3. The elbow.msh can be found in the folder.

Note:

ANSYS Fluent tutorials are prepared using ANSYS Fluent on a Windows system. The screen
shots and graphic images in the tutorials may be slightly different than the appearance
on your system, depending on the operating system and/or graphics card.

1.4.2. Launching ANSYS Fluent

1. From the Windows Start menu, select Start > ANSYS 2020 R1 > Fluent 2020 R1 to start Fluent
Launcher.

Fluent Launcher allows you to decide which version of ANSYS Fluent you will use, based on your
geometry and on your processing capabilities.
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2. Ensure that the proper options are enabled.

a. Select 3D from the Dimension list by clicking the radio button or the text.

b. Ensure that the Double Precision option is selected.

c. Ensure that the Display Mesh After Reading option is enabled.

d. Set Processes to 4 under the Parallel (local Machine).

Note:

Fluent will retain your preferences for future sessions.

3. Set the working folder to the one created when you unzipped introduction.zip.

a. Click the Show More Options button to reveal additional options.

b. Enter the path to your working folder for Working Directory by double-clicking the text box and
typing.

Alternatively, you can click the browse button ( ) next to the Working Directory text box
and browse to the directory, using the Browse For Folder dialog box.
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4. Click OK to launch ANSYS Fluent.
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For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent
Launcher in the Fluent Getting Started Guide.

1.4.3. Reading the Mesh

1. Read the mesh file elbow.msh.

Click the File ribbon tab, then click Read and Mesh... in the menus that open in order to open
the Select File dialog box.

File → Read → Mesh...
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a. Select the mesh file by clicking elbow.msh in the introduction folder created when you unzipped
the original file.

b. Enable the Display Mesh After Reading in the Select File dialog box.

c. Click OK to read the file and close the Select File dialog box.

As the mesh file is read by ANSYS Fluent, messages will appear in the console reporting the progress
of the conversion. ANSYS Fluent will report that 13,852 hexahedral fluid cells have been read,
along with a number of boundary faces with different zone identifiers.

After having completed reading mesh, ANSYS Fluent displays the mesh in the graphics window.

Extra:

You can use the mouse to probe for mesh information in the graphics window. If you
click the right mouse button with the pointer on any node in the mesh, information
about the associated zone will be displayed in the console, including the name of the
zone.
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Alternatively, you can click the probe button ( ) in the graphics toolbar and click
the left mouse button on any node. This feature is especially useful when you have
several zones of the same type and you want to distinguish between them quickly.

For this 3D problem, you can make it easier to probe particular nodes by changing the
view. The following table describes how to manipulate objects in the graphics window:

Table 1.1: View Manipulation Instructions

Using Graphics Toolbar Buttons and the MouseAction

After clicking the Rotate View icon, , press and hold the left mouse
button and drag the mouse. Dragging side to side rotates the view about

Rotate view
(vertical,
horizontal)

the vertical axis, and dragging up and down rotates the view about the
horizontal axis.

After clicking the Pan icon, , press and hold the left mouse button
and drag the object with the mouse until the view is satisfactory.

Translate or
pan view

After clicking the Zoom In/Out icon, , press and hold the left mouse
button and drag the mouse up and down to zoom in and out of the view.

Zoom in and
out of view

After clicking the Zoom to Area icon, , press and hold the left mouse
button and drag the mouse diagonally to the right. This action will cause

Zoom to
selected
area

a rectangle to appear in the display. When you release the mouse button,
a new view will be displayed that consists entirely of the contents of the
rectangle. Note that to zoom in, you must drag the mouse to the right,
and to zoom out, you must drag the mouse to the left.

Clicking the Fit to Window icon, , will cause the object to fit exactly and be
centered in the window.

After you have clicked a button in the graphics toolbar, you can return to the default

mouse button settings by clicking .

To judge the scale of your 3D geometry, you can click the Orthographic Projection

icon, . This will display the length scale ruler near the bottom of the graphics
window.

Note that you can change the default mouse button actions in the View tab (in the
Mouse group box). For more information, see the Fluent User's Guide.
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2. Manipulate the mesh display using the axis triad to obtain a front view as shown in Figure 1.2: The
Hexahedral Mesh for the Mixing Elbow (p. 9).

a. Click the z-axis.

b. Clicking the Fit to Window icon, , will cause the object to fit exactly and be centered in the
window.

c. Figure 1.2: The Hexahedral Mesh for the Mixing Elbow

Extra:

You can also change the orientation of the objects in the graphics window using the

axis triad  as follows:

• To orient the model in the positive/negative direction, click an axis/semi-sphere.

• To orient the model in the negative/positive direction, right-click an axis/semi-sphere.

• To set the isometric view, click the cyan iso-ball.
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• To perform in-plane clockwise or counterclockwise 90° rotations, click the white rotational
arrows .

• To perform free rotations in any direction, click and hold—in the vicinity of the triad—and
use the mouse. Release the left mouse button to stop rotating.

1.4.4. Setting Up Domain

In this step, you will perform the mesh-related activities using the Domain ribbon tab (Mesh group
box).

1. Check the mesh.

Domain → Mesh → Check → Perform Mesh Check

ANSYS Fluent will report the results of the mesh check in the console.

 Domain Extents:
   x-coordinate: min (m) = -8.000000e+00, max (m) = 8.000000e+00
   y-coordinate: min (m) = -9.134634e+00, max (m) = 8.000000e+00
   z-coordinate: min (m) = 0.000000e+00, max (m) = 2.000000e+00
 Volume statistics:
   minimum volume (m3): 5.098304e-04
   maximum volume (m3): 2.330736e-02
     total volume (m3): 1.607154e+02
 Face area statistics:
   minimum face area (m2): 4.865882e-03
   maximum face area (m2): 1.017924e-01
 Checking mesh....................................
Done.

The mesh check will list the minimum and maximum x, y, and z values from the mesh in the default
SI unit of meters. It will also report a number of other mesh features that are checked. Any errors
in the mesh will be reported at this time. Ensure that the minimum volume is not negative, since
ANSYS Fluent cannot begin a calculation when this is the case.

Note:

The minimum and maximum values may vary slightly when running on different plat-
forms.
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2. Scale the mesh.

Domain → Mesh → Scale...

a. Ensure that Convert Units is selected in the Scaling group box.

b. From the Mesh Was Created In drop-down list, select in by first clicking the down-arrow button and
then clicking the in item from the list that appears.

c. Click Scale to scale the mesh.

Warning:

Be sure to click the Scale button only once.

Domain Extents will continue to be reported in the default SI unit of meters.

d. Select in from the View Length Unit In drop-down list to set inches as the working unit for length.

e. Confirm that the domain extents are as shown in the previous dialog box.

f. Close the Scale Mesh dialog box.
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The mesh is now sized correctly and the working unit for length has been set to inches.

Note:

Because the default SI units will be used for everything except length, there is no need
to change any other units in this problem. The choice of inches for the unit of length
has been made by the actions you have just taken. If you want a different working unit
for length, other than inches (for example, millimeters), click Units... in the Domain
ribbon tab (Mesh group box) and make the appropriate change in the Set Units dialog
box.

3. Right click in the graphics window and select Refresh Display

4. Clicking the Fit to Window icon, , will cause the object to fit exactly and be centered in the window.

5. Check the mesh.
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Domain → Mesh → Check → Perform Mesh Check

Note:

It is a good idea to check the mesh after you manipulate it (that is, scale, convert to
polyhedra, merge, separate, fuse, add zones, or smooth and swap). This will ensure that
the quality of the mesh has not been compromised.

1.4.5. Setting Up Physics

In the steps that follow, you will select a solver and specify physical models, material properties, and
zone conditions for your simulation using the Physics ribbon tab.

1. In the Solver group box of the Physics ribbon tab, retain the default selection of the steady pressure-
based solver.

Physics → Solver → General
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2. Set up your models for the CFD simulation using the Models group box of the Physics ribbon tab.
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Note:

You can also use the Models task page, which can be accessed from the tree by ex-
panding Setup and double-clicking the Models tree item.

a. Enable heat transfer by activating the energy equation.

In the Physics ribbon tab, enable Energy (Models group box).

Physics → Models → Energy

Note:

You can also double-click the Setup/Models/Energy tree item and enable the energy
equation in the Energy dialog box.

b. Enable the k-ω turbulence model.

Physics → Models → Viscous...
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i. Retain the default selection of k-omega from the Model list.

ii. Retain the default selection of SST in the k-omega Model group box.

iii. Click OK to accept all the other default settings and close the Viscous Model dialog box.
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Note that the Viscous... label in the ribbon is displayed in blue to indicate that the Viscous
model is enabled. Also Energy and Viscous appear as enabled under the Setup/Models
tree branch.

Note:

While the ribbon is the primary tool for setting up and solving your problem,
the tree is a dynamic representation of your case. The models, materials, condi-
tions, and other settings that you have specified in your problem will appear in
the tree. Many of the frequently used ribbon items are also available via the
right-click functionality of the tree.

3. Set up the materials for the CFD simulation using the Materials group box of the Physics ribbon tab.

Create a new material called water using the Create/Edit Materials dialog box.

a. In the Physics ribbon tab, click Create/Edit... (Materials group box).

Physics → Materials → Create/Edit...
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b. Click the Fluent Database... button to access pre-defined materials.

c. Select water-liquid (h2o < l >) from the materials list and click Copy, then close the Fluent Database...
dialog box.
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d. Ensure that there are now two materials (water-liquid and air) defined locally by examining the Fluent
Fluid Materials drop-down list.

Both the materials will also be listed under Fluid in the Materials task page and under the Mater-
ials tree branch.

e. Close the Create/Edit Materials dialog box.

4. Set up the cell zone conditions for the fluid zone (fluid) using the Zones group box of the Physics ribbon
tab.
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a. In the Physics tab, click Cell Zones (Zones group box).

Physics → Zones → Cell Zones

This opens the Cell Zone Conditions task page.
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b. Double-click fluid in the Zone list to open the Fluid dialog box.
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Note:

You can also double-click the Setup/Cell Zone Conditions/fluid tree item in order
to open the corresponding dialog box.

c. Select water-liquid from the Material Name drop-down list.

d. Click OK to close the Fluid dialog box.

5. Set up the boundary conditions for the inlets, outlet, and walls for your CFD analysis using the Zones
group box of the Physics ribbon tab.

a. In the Physics tab, click Boundaries (Zones group box).

Physics → Zones → Boundaries

This opens the Boundary Conditions task page where the boundaries defined in your simula-
tion are displayed in the Zone selection list.
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Note:
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To display boundary zones grouped by zone type (as shown previously), click the

Toggle Tree View button ( ) in the upper right corner of the Boundary Condi-
tions task page and select Zone Type under Group By.

Here the zones have names with numerical identifying tags. It is good practice to give
boundaries meaningful names in a meshing application to help when you set up the model.
You can also change boundary names in Fluent by simply editing the boundary and making
revisions in the Zone Name text box.

b. Set the boundary conditions at the cold inlet (velocity-inlet-5).

Tip:

If you are unsure of which inlet zone corresponds to the cold inlet, you can
probe the mesh display using the right mouse button or the probe toolbar

button ( ) as described previously in this tutorial. The information will be
displayed in the ANSYS Fluent console, and the zone you probed will be auto-
matically selected from the Zone selection list in the Boundary Conditions
task page.

i. Double-click velocity-inlet-5 to open the Velocity Inlet dialog box.
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ii. Retain the default selection of Magnitude, Normal to Boundary from the Velocity Specification
Method drop-down list.

iii. Enter 0.4 [m/s] for Velocity Magnitude.

iv.  In the Turbulence group box, select Intensity and Hydraulic Diameter from the Specification
Method drop-down list.

v. Retain the default value of 5 [%] for Turbulent Intensity.

vi. Enter 4 [inches] for Hydraulic Diameter.

The hydraulic diameter  is defined as:

where  is the cross-sectional area and  is the wetted perimeter.

vii. Click the Thermal tab.

viii.Enter 293.15 [K] for Temperature.
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ix. Click OK to close the Velocity Inlet dialog box.

Note:

You can also access the Velocity Inlet dialog box by double-clicking the
Setup/Boundary Conditions/velocity-inlet-5 tree item.

c. In a similar manner, set the boundary conditions at the hot inlet (velocity-inlet-6), using the values
in the following table:

ValueSetting

Magnitude, Normal to BoundaryVelocity Specification Method

1.2 [m/s]Velocity Magnitude

Intensity and Hydraulic DiameterSpecification Method

5 [%]Turbulent Intensity

1 [inch]Hydraulic Diameter

313.15 [K]Temperature

d. Double-click pressure-outlet-7 in the Zone selection list and set the boundary conditions at the
outlet, as shown in the following figure.
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Note:

• You do not need to set a backflow temperature in this case (in the Thermal tab) because
the material properties are not functions of temperature. If they were, a flow-weighted
average of the inlet conditions would be a good starting value.

• ANSYS Fluent will use the backflow conditions only if the fluid is flowing into the com-
putational domain through the outlet. Since backflow might occur at some point during
the solution procedure, you should set reasonable backflow conditions to prevent
convergence from being adversely affected.

e. For the wall of the pipe (wall), retain the default value of 0 W/m2 for Heat Flux in the Thermal tab.
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1.4.6. Solving

In the steps that follow, you will set up and run the calculation using the Solution ribbon tab.

Note:

You can also use the task pages listed under the Solution tree branch to perform solution-
related activities.

1. Select a solver scheme.

a. In the Solution ribbon tab, click Methods... (Solution group box).
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Solution → Solution → Methods...
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b. Retain the default selections.

2. Enable the plotting of residuals during the calculation.

a. In the Solution ribbon tab, click Residuals... (Reports group box).

Solution → Reports → Residuals...

Note:

You can also access the Residual Monitors dialog box by double-clicking the
Solution/Monitors/Residual tree item.

b. Ensure that Plot is enabled in the Options group box.

c. Retain the default value of 0.001 for the Absolute Criteria of continuity.
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d. Click OK to close the Residual Monitors dialog box.

Note:

By default, the residuals of all of the equations solved for the physical models enabled
for your case will be monitored and checked by ANSYS Fluent as a means to determine
the convergence of the solution. It is a good practice to also create and plot a surface
report definition that can help evaluate whether the solution is truly converged. You
will do this in the next step.

3. Create a surface report definition of average temperature at the outlet (pressure-outlet-7).

Solution → Reports → Definitions → New → Surface Report → Mass-Weighted Average...
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Note:

You can also access the Surface Report Definition dialog box by right-clicking Report
Definitions in the tree (under Solution) and selecting New/Surface Report/Mass-
Weighted Average... from the menu that opens.

a. Enter outlet-temp-avg for the Name of the report definition.

b. Enable Report File, Report Plot, and Print to Console in the Create group box.

During a solution run, ANSYS Fluent will write solution convergence data in a report file, plot the
solution convergence history in a graphics window, and print the value of the report definition to
the console.
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c. Set Frequency to 3 by clicking the up-arrow button.

This setting instructs ANSYS Fluent to update the plot of the surface report, write data to a file, and
print data in the console after every 3 iterations during the solution.

d. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

e. Select pressure-outlet-7 from the Surfaces selection list.

f. Click OK to save the surface report definition and close the Surface Report Definition dialog box.

The new surface report definition outlet-temp-avg will appear under the Solution/Report
Definitions tree item. ANSYS Fluent also automatically creates the following items:

• outlet-temp-avg-rfile (under the Solution/Monitors/Report Files tree branch)

• outlet-temp-avg-rplot (under the Solution/Monitors/Report Plots tree branch)

4. In the tree, double-click outlet-temp-avg-rfile (under Solution/Monitors/Report Files) and examine
the report file settings in the Edit Report File dialog box.

The dialog box is automatically populated with data from the outlet-temp-avg report definition.

a. Verify that outlet-temp-avg is in the Selected Report Definitions list.
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If you had created multiple report definitions, the additional ones would be listed under Available
Report Definitions, and you could use the Add>> and <<Remove buttons to manage which
were written in this particular report definition file.

b. (optional) Edit the name and location of the resulting file as necessary using the File Name field or
Browse... button.

c. Click OK to close the Edit Report File dialog box.

5. Create a convergence condition for outlet-temp-avg.

Solution → Reports → Convergence...

a. Click the Add button.

b. Enter con-outlet-temp-avg for Conditions.

c. Select outlet-temp-avg from the Report Definition drop-down list.

d. Enter 1e-5 for Stop Criterion.

e. Enter 20 for Ignore Iterations Before.

f. Enter 15 for Use Iterations.

g. Enable Print.
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h. Set Every Iteration to 3.

i. Click OK to save the convergence condition settings and close the Convergence Conditions dialog
box.

These settings will cause Fluent to consider the solution converged when the surface report definition
value for each of the previous 15 iterations is within 0.001% of the current value. Convergence of the
values will be checked every 3 iterations. The first 20 iterations will be ignored, allowing for any initial
solution dynamics to settle out. Note that the value printed to the console is the deviation between
the current and previous iteration values only.

6. Initialize the flow field using the Initialization group box of the Solution ribbon tab.

Solution → Initialization

a. Retain the default selection of Hybrid from the Method list.

b. Click Initialize.

7. Save the case file (elbow1.cas.h5).

File → Write → Case...
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a. (optional) Indicate the folder in which you would like the file to be saved.

By default, the file will be saved in the folder from which you read in elbow.msh (that is, the
introduction folder). You can indicate a different folder by browsing to it or by creating a new
folder.

b. Enter elbow1.cas.h5 for Case File.

c. Ensure that the default Write Binary Files option is enabled, so that a binary file will be written.

d. Click OK to save the case file and close the Select File dialog box.

8. Start the calculation by requesting 150 iterations in the Solution ribbon tab (Run Calculation group
box).

Solution → Run Calculation
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a. Enter 150 for No. of Iterations.

b. Click Calculate.

Note:

By starting the calculation, you are also starting to save the surface report data at
the rate specified in the Surface Report Definition dialog box. If a file already exists
in your working directory with the name you specified in the Edit Report File dialog
box, then a Question dialog box will open, asking if you would like to append the
new data to the existing file. Click No in the Question dialog box, and then click
OK in the Warning dialog box that follows to overwrite the existing file.

As the calculation progresses, the surface report history will be plotted in the outlet-temp-
avg-rplot tab in the graphics window (Figure 1.3: Convergence History of the Mass-Weighted
Average Temperature (p. 37)).

Figure 1.3: Convergence History of the Mass-Weighted Average Temperature

Similarly, the residuals history will be plotted in the Scaled Residuals tab in the graphics
window (Figure 1.4: Residuals (p. 38)).
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Figure 1.4: Residuals

Note:

You can monitor the two convergence plots simultaneously by right-clicking a tab
in the graphics window and selecting SubWindow View from the menu that opens.
To return to a tabbed graphics window view, right-click a graphics window title
area and select Tabbed View.

Since the residual values vary slightly by platform, the plot that appears on your screen may
not be exactly the same as the one shown here.

The solution will be stopped by ANSYS Fluent when any of the following occur:

• the surface report definition converges to within the tolerance specified in the Convergence
Conditions dialog box

• the residual monitors converge to within the tolerances specified in the Residual Monitors
dialog box

• the number of iterations you requested in the Run Calculation task page has been reached

In this case, the solution is stopped when the convergence criterion on outlet temperature is
satisfied. The exact number of iterations for convergence will vary, depending on the platform
being used. An Information dialog box will open to alert you that the calculation is complete.
Click OK in the Information dialog box to proceed.
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9. Examine the plots for convergence (Figure 1.3: Convergence History of the Mass-Weighted Average
Temperature (p. 37) and Figure 1.4: Residuals (p. 38)).

Note:

There are no universal metrics for judging convergence. Residual definitions that are
useful for one class of problem are sometimes misleading for other classes of problems.
Therefore it is a good idea to judge convergence not only by examining residual levels,
but also by monitoring relevant integrated quantities and checking for mass and energy
balances.

There are three indicators that convergence has been reached:

• The residuals have decreased to a sufficient degree.

The solution has converged when the Convergence Criterion for each variable has
been reached. The default criterion is that each residual will be reduced to a value

of less than 10–3, except the energy residual, for which the default criterion is 10–6.

• The solution no longer changes with more iterations.

Sometimes the residuals may not fall below the convergence criterion set in the case
setup. However, monitoring the representative flow variables through iterations may
show that the residuals have stagnated and do not change with further iterations.
This could also be considered as convergence.

• The overall mass, momentum, energy, and scalar balances are obtained.

You can examine the overall mass, momentum, energy and scalar balances in the
Flux Reports dialog box. The net imbalance should be less than 0.2 % of the net
flux through the domain when the solution has converged. In the next step you will
check to see if the mass balance indicates convergence.

10. Examine the mass flux report for convergence using the Results ribbon tab.

Results → Reports → Fluxes...
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a. Ensure that Mass Flow Rate is selected from the Options list.

b. Select pressure-outlet-7, velocity-inlet-5, and velocity-inlet-6 from the Boundaries selection list.

c. Click Compute.

The individual and net results of the computation will be displayed in the Results and Net Results
boxes, respectively, in the Flux Reports dialog box, as well as in the console.

The sum of the flux for the inlets should be very close to the sum of the flux for the outlets. The net
results show that the imbalance in this case is well below the 0.2% criterion suggested previously.

d. Close the Flux Reports dialog box.

11. Save the data file (elbow1.dat.h5).

File → Write → Data...

In later steps of this tutorial you will save additional case and data files with different suffixes.

1.4.7. Displaying the Preliminary Solution

In the steps that follow, you will visualize various aspects of the flow for the preliminary solution using
the Results ribbon tab.

1. Display filled contours of velocity magnitude on the symmetry plane (Figure 1.5: Predicted Velocity Dis-
tribution after the Initial Calculation (p. 43)).

Results → Graphics → Contours → New...
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a. Enter contour-vel for Contour Name.

b. Enable Filled in the Options group box.

c. Ensure that Node Values and Boundary Values are enabled in the Options group box.

d. Select Banded in the Coloring group box.

e. Select Velocity... and Velocity Magnitude from the Contours of drop-down lists.

f. Select symmetry from the Surfaces selection list.
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g. Click Save/Display to display the contours in the active graphics window. Clicking the Fit to Window

icon ( ) will cause the object to fit exactly and be centered in the window.

Note:

If you cannot see the velocity contour display, select the appropriate tab in the
graphics window.

h. Close the Contours dialog box.

View → Display

Disable the Headlight and Lighting options.
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Figure 1.5: Predicted Velocity Distribution after the Initial Calculation

Extra:

When you probe a point in the displayed domain with the right mouse button or the
probe tool, the level of the corresponding contour is highlighted in the colormap in
the graphics window, and is also reported in the console.

2. Create and display a definition for temperature contours on the symmetry plane (Figure 1.6: Predicted
Temperature Distribution after the Initial Calculation (p. 45)).

Results → Graphics → Contours → New...

You can create contour definitions and save them for later use.
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a. Enter contour-temp for Contour Name.

b. Select Temperature... and Static Temperature from the Contours of drop-down lists.

c. Select symmetry from the Surfaces selection list.

d. Click Save/Display and close the Contours dialog box.

The new contour-temp definition appears under the Results/Graphics/Contours tree branch.
To edit your contour definition, right-click it and select Edit... from the menu that opens.
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Figure 1.6: Predicted Temperature Distribution after the Initial Calculation

3. Display velocity vectors on the symmetry plane (Figure 1.9: Magnified View of Resized Velocity Vec-
tors (p. 49)).

Results → Graphics → Vectors → New...
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a. Enter vector-vel for Vector Name.

b. Select arrow from the Style drop-down box.

c. Select symmetry from the Surfaces selection list.

d. Click Save/Display to plot the velocity vectors.
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Figure 1.7: Velocity Vectors Colored by Velocity Magnitude

The Auto Scale option is enabled by default in the Options group box. This scaling sometimes
creates vectors that are too small or too large in the majority of the domain. You can improve
the clarity by adjusting the Scale and Skip settings, thereby changing the size and number
of the vectors when they are displayed.

e. Enter 4 for Scale.

f. Set Skip to 2.

g. Click Save/Display again to redisplay the vectors.
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Figure 1.8: Resized Velocity Vectors

h. Close the Vectors dialog box.

i. Zoom in on the vectors in the display.

To manipulate the image, refer to Table 1.1: View Manipulation Instructions (p. 8). The image will
be redisplayed at a higher magnification (Figure 1.9: Magnified View of Resized Velocity Vec-
tors (p. 49)).
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Figure 1.9: Magnified View of Resized Velocity Vectors

j. Zoom out to the original view.

Clicking the Fit to Window icon, , will cause the object to fit exactly and be centered in
the window.

4. Create a line at the centerline of the outlet. For this task, you will use the Surface group box of the Results
tab.

Results → Surface → Create → Iso-Surface...
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a. Enter z=0_outlet for New Surface Name.

b. Select Mesh... and Z-Coordinate from the Surface of Constant drop-down lists.

c. Click Compute to obtain the extent of the mesh in the z-direction.

The range of values in the z-direction is displayed in the Min and Max fields.

d. Retain the default value of 0 inches for Iso-Values.

e. Select pressure-outlet-7 from the From Surface selection list.

f. Click Create.

The new line surface representing the intersection of the plane z=0 and the surface pressure-
outlet-7 is created, and its name z=0_outlet appears in the From Surface selection list.

Note:

• After the line surface z=0_outlet is created, a new entry will automatically be generated
for New Surface Name, in case you would like to create another surface.

• If you want to delete or otherwise manipulate any surfaces, click Manage... to open
the Surfaces dialog box.

g. Close the Iso-Surface dialog box.
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5. Display and save an XY plot of the temperature profile across the centerline of the outlet for the initial
solution (Figure 1.10: Outlet Temperature Profile for the Initial Solution (p. 52)).

Results → Plots → XY Plot → New...

a. Enter xy-outlet-temp for XY Plot Name.

b. Select Temperature... and Static Temperature from the Y Axis Function drop-down lists.

c. Select the z=0_outlet surface you just created from the Surfaces selection list.

d. Click Save/Plot.

e. Enable Write to File in the Options group box.

The button that was originally labeled Save/Plot will change to Write....

f. Click Write....

i. In the Select File dialog box, enter outlet_temp1.xy for XY File.

ii. Click OK to save the temperature data and close the Select File dialog box.

g. Close the Solution XY Plot dialog box.
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Figure 1.10: Outlet Temperature Profile for the Initial Solution

6. Define a custom field function for the dynamic head formula ( ).

User-Defined → Field Functions → Custom...

a. Select Density... and Density from the Field Functions drop-down lists, and click the Select button
to add density to the Definition field.

b. Click the X button to add the multiplication symbol to the Definition field.

c. Select Velocity... and Velocity Magnitude from the Field Functions drop-down lists, and click the
Select button to add |V| to the Definition field.
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d. Click y^x to raise the last entry in the Definition field to a power, and click 2 for the power.

e. Click the / button to add the division symbol to the Definition field, and then click 2.

f. Enter dynamic-head for New Function Name.

g. Click Define and close the Custom Field Function Calculator dialog box.

The dynamic-head tree item will appear under the Parameters & Customization/Custom
Field Functions tree branch.

7. Display filled contours of the custom field function (Figure 1.11: Contours of the Dynamic Head Custom
Field Function (p. 54)).

Results → Graphics → Contours → New...

a. Enter contour-dynamic-head for Contour Name.
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b. Select Banded in the Coloring group box.

c. Select Custom Field Functions... and dynamic-head from the Contours of drop-down lists.

Tip:

Custom Field Functions... is at the top of the upper Contours of drop-down
list.

d. Select symmetry from the Surfaces selection list.

e. Click Save/Display and close the Contours dialog box.

Figure 1.11: Contours of the Dynamic Head Custom Field Function

Note:

You may need to change the view by zooming out after the last vector display, if you
have not already done so.

8. Save the settings for the custom field function by writing the case and data files (elbow1.cas.h5 and
elbow1.dat.h5).
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File → Write → Case & Data...

a. Ensure that elbow1.cas.h5 is entered for Case/Data File.

Note:

When you write the case and data file at the same time, it does not matter whether
you specify the file name with a .cas.h5 or .dat.h5 extension, as both will be
saved.

b. Click OK to save the files and close the Select File dialog box.

c. Click OK to overwrite the files that you had saved earlier.

1.4.8. Adapting the Mesh

For the first run of this tutorial, you have solved the elbow problem using a fairly coarse mesh. The
elbow solution can be improved further by refining the mesh to better resolve the flow details. ANSYS
Fluent provides a built-in capability to easily adapt (locally refine) the mesh according to solution
gradients. In the following steps you will adapt the mesh based on the temperature gradients in the
current solution and compare the results with the previous results.

1. Define Cell Registers to Adapt the mesh in the regions of high temperature gradient.

Solution → Cell Registers New → Field Variable...
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a. Select Cells More Than from the Type drop-down list.

b. Select Curvature from the Derivative Option drop-down list.

c. Select Temperature... and Static Temperature from the Curvature of drop-down list.

d. Click Compute.

ANSYS Fluent will update the Min and Max values to show the minimum and maximum temper-
ature gradient.

e. Enter a value of 0.003 for the Cells having value more than.

A general rule is to use 10% of the maximum gradient when setting the value for refinement.

f. Click Save and close the Field Variable Register daialog box.

2. Setup mesh adaption using the Cell Registers. For this task, you will use the Adapt group box in the
Domain ribbon tab.

Domain → Adapt → Refine / Coarsen...
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a. Select the previously defined curvature_0 cell register from the Refinement Criterion drop-down
list.

ANSYS Fluent will not coarsen beyond the original mesh for a 3D mesh. Hence, it is not necessary
to select the Coarsening Criterion in this instance.

b. Click Adapt.

c. Click Display.

ANSYS Fluent will display the cells marked for adaption in the graphics window (Figure 1.12: Cells
Marked for Adaption (p. 59)).
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Figure 1.12: Cells Marked for Adaption

Extra You can change the way ANSYS Fluent displays cells marked for adaption (Figure 1.13: Al-
ternative Display of Cells Marked for Adaption (p. 61)) by performing the following steps:

i. Click Display Options... in the Adaption Controls dialog box to open the Display Options
- Adaption dialog box.

ii. Enable Draw Mesh in the Options group box.
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The Mesh Display dialog box will open.

iii. Ensure that only the Edges option is enabled in the Options group box.

iv. Select Feature from the Edge Type list.

v. Select all of the items except z=0_outlet from the Surfaces selection list.

vi. Click Display and close the Mesh Display dialog box.

vii. Click OK to close the Display Options - Adaption dialog box.

viii.Click Display in the Adaption Controls dialog box.

ix. Rotate the view and zoom in to get the display shown in Figure 1.13: Alternative Display
of Cells Marked for Adaption (p. 61).
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Figure 1.13: Alternative Display of Cells Marked for Adaption

x. After viewing the marked cells, rotate the view back and zoom out again.

xi. Click OK to close the Adaption Controls dialog box.

3. Display the adapted mesh (Figure 1.14: The Adapted Mesh (p. 63)).

Domain → Mesh → Display...
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a. Select All from the Edge Type list.

b. Deselect all of the highlighted items from the Surfaces selection list except for symmetry.

Tip:

To deselect all surfaces, click the Deselect All Shown button ( ) at the top of
the Surfaces selection list. Then select the desired surface from the Surfaces selec-
tion list.

c. Click Display and close the Mesh Display dialog box.

Release 2020 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.62

Fluid Flow and Heat Transfer in a Mixing Elbow



Figure 1.14: The Adapted Mesh

4. Request an additional 90 iterations.

Solution → Run Calculation → Calculate

The solution will converge as shown in Figure 1.15: The Complete Residual History (p. 64) and Fig-
ure 1.16: Convergence History of Mass-Weighted Average Temperature (p. 64).
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Figure 1.15: The Complete Residual History

Figure 1.16: Convergence History of Mass-Weighted Average Temperature

5. Save the case and data files for the Coupled solver solution with an adapted mesh (elbow2.cas.h5
and elbow2.dat.h5).

File → Write → Case & Data...

a. Enter elbow2.h5 for Case/Data File.

b. Click OK to save the files and close the Select File dialog box.

The files elbow2.cas.h5 and elbow2.dat.h5 will be saved in your default folder.
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6. Display the temperature distribution (using node values) on the revised mesh using the temperature
contours definition that you created earlier (Figure 1.17: Filled Contours of Temperature Using the Adapted
Mesh (p. 65)).

Right-click the Results/Graphics/Contours/contour-temp tree item and select Display from the
menu that opens.

Results → Graphics → Contours → contour-temp Display

Figure 1.17: Filled Contours of Temperature Using the Adapted Mesh

7. Display and save an XY plot of the temperature profile across the centerline of the outlet for the adapted
solution (Figure 1.18: Outlet Temperature Profile for the Adapted Coupled Solver Solution (p. 66)).

Results → Plots → XY Plot → xy-outlet-temp Edit...

a. Click Save/Plot to display the XY plot.
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Figure 1.18: Outlet Temperature Profile for the Adapted Coupled Solver Solution

b. Enable Write to File in the Options group box.

The button that was originally labeled Save/Plot will change to Write....

c. Click Write....

i. In the Select File dialog box, enter outlet_temp2.xy for XY File.

ii. Click OK to save the temperature data.

d. Close the Solution XY Plot dialog box.

8. Display the outlet temperature profiles for both solutions on a single plot (Figure 1.19: Outlet Temperature
Profiles for the Two Solutions (p. 68)).

a. Open the Plot Data Sources dialog box.

Results → Plots → Data Sources...
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b. Click the Load File... button to open the Select File dialog box.

i. Select outlet_temp1.xy and outlet_temp2.xy.
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Each of these files will be listed with their folder path in the bottom list to indicate that they
have been selected.

Tip:

If you select a file by mistake, simply click the file in the bottom list and
then click Remove.

ii. Click OK to save the files and close the Select File dialog box.

c. Select the folder path ending in outlet_temp1.xy from the Curve Information selection list (Curves
group box).

d. Enter Before Adaption in the lower-right text-entry box.

e. Click the Change Legend Entry button.

The item in the Legend Entries list for outlet_temp1.xy will be changed to Before Adaption. This
legend entry will be displayed in the upper-left corner of the XY plot generated in a later step.

f. In a similar manner, change the legend entry for the folder path ending in outlet_temp2.xy to be
Adapted Mesh.

g. Click Plot and close the Plot Data Sources dialog box.

Figure 1.19: Outlet Temperature Profiles for the Two Solutions (p. 68) shows the two temperature profiles
at the centerline of the outlet. It is apparent by comparing both the shape of the profiles and the pre-
dicted outer wall temperature that the solution is highly dependent on the mesh and solution options.
Specifically, further mesh adaption should be used in order to obtain a solution that is independent
of the mesh.

Figure 1.19: Outlet Temperature Profiles for the Two Solutions
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1.5. Summary

The solution results are changed by the adaption of the mesh, which indicates that a sufficiently refined
mesh is required to obtain a mesh independent solution.
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